
Biblos Overview
What is Biblos?

Biblos is a system that delivers electronic reference books to your PC in a way that looks and feels like 
conventional books. Biblos offers you ease of use, interoperability with your conventional books and 
manuals, and sophisticated searching and cross referencing tools.

Using books
How to open or close books and move around within them.

Organising books
How to use Biblos`s libraries to organise your books.

Searching
How to use Biblos`s sophisticated search engine

Cross Referencing
Using topics to build cross-references within and between your books



Using Books

Everything in Biblos is based around the concept of the book. Biblos allows you to build bookshelves of 
your books called libraries. At any time, you can browse through the libraries and open the books you 
need.

Once you have opened a book, you can move about by turning pages, selecting chapters, using the 
Goto system or opening the book`s Table of contents. You can have as many books open as you like-
you are limited only by screen space and the amount of memory on your PC. You can also open the 
same book more than onceperhaps to compare a chapter with an Appendix.

Once a book is open, you have a great deal of control over how you view it. The Zoom View and Format 
controls let you adjust your view of each book to suit your needs. The Magnifier Window allows you to 
read your books whilst keeping the layout visible.

You can close books and still use them in searches.



Opening Books

There are two main techniques for opening books: 

Using the Book Open dialog

Select Open... from the Book menu or press the open book button on the Toolbar. Choose a library that 
contains the book you want to open. If you aren`t sure which library your book is in, look in the library 
Main Library as this contains all books. The Info button shows additional information about the selected 
book such as Book Title, Author, Publisher, and ISBN number.

Using the bookshelf

You can show the bookshelf by pressing the shelf button on the Toolbar or by selecting Shelf from the 
View menu. The bookshelf is shown across the top of the screen. The books on the shelf are determined
by the library that is currently active. This is shown on the status line at the bottom of the screen. To 
change library, you can select a new one by:

clicking on the library name in the status line and selecting a different one from the list;
using the small up and down arrows at the left hand end of the shelf to cycle through the available

libraries; or
choosing Select... from the Library menu.

To open a book, simply click on it. Clicking on an open book will close it. 

If the book you want is not visible on the shelf, use the left and right buttons at the left hand end of the 
shelf to rotate the books until you can see the one you want.

See also:
Bookshelf
Closing Books
Libraries



User Details

When you start Biblos for the first time, the user details dialog appears asking for your first name and full
name. These details are used by biblos to control the location of your personal directory on a network 
and so that the Biblos administrator can see who is using the system at any time.



Closing Books

You can close books by:
clicking on open books on the shelf; or
selecting Close from the Book menu (this closes the currently active book as shown on the status

line. You can change the currently active open book by clicking on any part of the one you wish to make 
active, or by selecting a different on from the pop-up list on the status line).

See also:
Bookshelf



Moving around within books

Moving around within Biblos books is similar to moving about in a conventional book. You can turn 
pages, go to a specific page, go to a specific chapter or to the start or end of the book. Biblos provides a
wide range of ways to do all of these.

If you have several books open at a time, you need to choose which one you`re working with before you 
can change chapter or turn pages. You can select an open book simply by clicking on any visible part of 
it, or by selecting it from the pop-up list on the status line.



Turning Pages

To move backwards or forwards a page, either:
press the Page Up or Page Down keys; or
click on the curl in the bottom left and right hand corner of the book (this may not be visible if you 

are using a zoomed-in view of a book); or
select Next Page or Previous Page from the Navigate menu; or
click the forwards or backwards buttons on the Toolbar; or
use the cursor keys to move off the top or bottom of a page and on to the next one.

Note: you can go to a specific page using the Goto tool

See also:
Goto
Moving to the start or end of a book
Changing chapters and sections



Moving to the start or end of a book

To move to the start or end of a book:
select Start of Book or End of Book from the Navigate menu; or
click the start or end buttons on the Toolbar

See also:
Turning Pages
Changing Chapters and Sections



Changing Chapters and Sections

Biblos books consist of one or more chapters. Each chapter can be further divided into sections and the 
sections can be further subdivided. The number of levels and their names will differ from book to book 
as these can be defined by when a book is converted to Biblos. If you want to go to a particular 
subsection of a chapter, you should use the Contents windows or the Goto tool.    

To move backwards or forwards a chapter at a time:
select Next Chapter or Previous Chapter from the Navigate menu; or
click the next chapter or previous chapter button on the Toolbar.

To select a particular chapter:
click on the tabs at the side of the book. These will take you to the chapter named on the tab; or
select a chapter from the pop-up list on the status line; or
use the Goto tool to pick a chapter or section within a chapter; or use the Contents window to pick

a chapter or section within a chapter.

See also:
Turning pages
Moving to the start or end of a book
Table of contents
Goto
Status line



Smart Tile

The Smart Tile button arranges all your open windows into the best layout for using Biblos. Open books 
are tiled one above the other or side by side depending on how you are viewing them, the Contents 
Window is moved to the left hand side and the search hits window is moved to the bottom of the screen.

See also:
Toolbar



Book Format

The Book Format controls define how each book appears. The Book Format settings can be different for
each open book. You can choose from:

a single page view that presents half of an open book. As you turn the pages, the book flips over 
to show you either the left or right hand side of the active book and the chapter tabs on that side. This 
view is useful for zooming in on smaller or lower resolution screens:

a double page view that shows a full open book with chapter tabs on both sides. 

Either view can be stretched to any size required.

To change the book format:
select either One Page or Two Pages from the View menu; or
press one of the Book format buttons on the Toolbar;

See also:
Zoom
Magnifying Window
Smart Tile



Zoom

The Zoom control defines how near or far away the text in your books is. The Zoom settings can be 
different for each open book. There are three categories of zoom:

Fit to width-where the active book is zoomed so that the current book format completely fills the 
width of the book window. You may need to change the book format to a single page view to get readable 
text on smaller screens in this mode;

Fit to page-where the active book is zoomed so that the whole of the current book format is 
visible in the book window. This gives an overview of how the whole one or two-page spread looks.

Zoom percentage-where the active book is shown at a selected percentage of normal size in the
book window. For example, to see particularly small text in a book, you set the zoom level to 200% to 
show a book at twice normal size.

In the Fit to Width and Zoom Percentage modes, book windows have scroll lines to allow you to move to
the portion of the view that is outside the window area

To change the Zoom setting:

choose Zoom... from the View menu and choose a suitable format; or
select the appropriate Zoom setting from the Status Line; or
press the Last Zoom, Fit to Page or Fit to Width buttons on theToolbar.

See also:
Book Format
Magnifying Window
Smart Tile



Magnifying Window

The magnifying window allows you to read sections from a full page view of a book on small or low 
resolution screens. For example, it is often useful to look at a book in Fit to Page mode to get an idea of 
page layout and context. However, on most smaller screens, books are unreadable in this format. The 
Magnifying Window magnifies a small section of the overall view to a level that is easily readable. The 
area shown in the Magnifying Window can be moved by dragging a rectangle in the book view window.

Further, the Magnifying Window will adjust to show the exact position when you make a selection from 
the Accesories Window, Contents Window or Search Result List.

Using the Magnifying Window

The magnifying window appears at the bottom of your screen immediately above the status line, if 
visible.

To open the Magnifying Window either:

Select Magnifier from the View menu;
Select the Magnifier button from the Toolbar; or
Position the mouse over the Magnifying Window until the pointer turns into a double-headed 

arrow. You can then drag the magnifying window up to a maximum height of roughly one third of your 
screen.

Once the Magnifying Window is open, you will notice a rectangle shown on the face of the open books. 
This rectangle shows the area that is expanded in the Magnifying Window. To move the expanded area, 
simply drag the rectangle to the part of the book you want to see. In a two page view, you can drag the 
rectangle to either side of the view. As you select different active books, the area shown in the 
Magnifying Window will change accordingly.

See also:
Book Format
Zoom
Searching



Goto

The Goto tool is a quick way to get a particular page, chapter, section or book regardless of the books 
that are currently open. There are two ways to use the Goto tool:

click on the Page ... section of the status line;
click on the Goto button on the Toolbar; or
choose Goto... from the Navigate menu.

The Goto dialog has the following sections:

Library Allows you to select from the available libraries. By default, the current library is 
selected.

Book Allows you to select a book from the library chosen above. If you aren`t sure 
which library you book is in then choose the Main Library as this contains all the 
books on your system.

Goto type Allows you to select the type of location you want to move to. This can be either a
Page Number or a Contents Chapter.

Page no If you selected a Goto type of Page Number, then you can enter the particular 
page you want to go to.

Level 1, Level 2 If you selected Contents chapter as the Goto type, you can pick the first and 
second levels of the contents for the chosen book. For example you could pick 
`Chapter 2` as level 1 and `Section 2.25` as level 2.

Goto Goes to the location selected above.

See also:
Table of contents



Toolbar Buttons

These are the Biblos toolbar buttons. Click on any button to see what it does.



Toolbars

The Toolbars provides a set of buttons that give you quick access, via the mouse, to the main features of
Biblos. For example, you can turn the bookshelf on or off by pressing the Shelf button on the top Toolbar.

All the buttons on the Toolbars are activated by a single click. Some of the buttons are state buttons 
which allow you to pick, for example, a book Format view from the three available. Others are 
independent and activate functions such as printing. All button functions can be accessed from the 
Biblos menus and, in some cases by keyboard shortcuts.

You can control whether or not the Toolbars are shown and their position with the Toolbars... option from 
the View menu. This dialog allows you to choose one of the following options for the Main and 
Accessory toolbars (accessories are the bookmarks and sticky notes that you can put into Biblos books):

Show at top of window Positions the toolbar at the top of the active window. The main toolbar 
will always appear above the accessories toolbar.

Show at bottom of window Positions the toolbar at the bottom of the active window. The main 
toolbar will always appear above the accessories toolbar.

Hide the toolbar The toolbar will not be visible.



Preferences

Preferences allow you to customize Biblos to work in the way that you want it to. When you change your
preferences, they are recorded for this and all subsequent sessions. No other users of Biblos are 
affected.

To change your Biblos preferences, select Preferences... from the Edit menu. The available options are:

Sort hitlist by

Controls how the results of a search are presented. The list can be sorted by the location of the result, 
the relevance score of the result or the type of the result (book or accessory).

Sort books on

Controls how the books are ordered when you view a shelf. You may select one of Title, Author or 
Publisher. Each option will sort the books into ascending order so that A starts at the left and Z ends at 
the right.

Show available cover bitmaps

This option controls whether books are shown with their picture cover (if available) or a simple text 
cover.

Show ToolTips

ToolTips are the help balloons that appear over items on the toolbar and books on your shelves. They 
appear if the mouse has been over the item for longer than half a second. If you find ToolTips distracting,
you can turn them off by unchecking the box.

Show Flyby Help

Flyby Help is the help messages that appear in the status line as your mouse pointer moves over menu 
items, toolbar buttons and books on the shelf. If you find Flyby Help distracting, you can turn the feature 
off by unchecking this box.

Goto the exact position on a page

When you perform any sort of action that goes to a specific portion of text such as selecting an item from
the Contents Window, selecting an item from the search results list or using Goto Contents chapter, 
Biblos will attempt to move the main book view and the Magnifying Window to the exact point you 
selected. If you uncheck this option, Biblos will take move the main book view and the Magnifying 
Window to the top of the page on which your selected item appears.

Tile when any window is opened

By default, Biblos will do a Smart Tile when you open a new book, perform a search or view the 
Contents Window. If you do not wish Biblos to perform these automatic Smart Tiles then you should 



uncheck this option.

See also:
Bookshelf
Searching
Magnifying Window
Goto
Smart Tile
Opening Books



Status Line

The status line is the strip that runs along the bottom of the screen and shows information about the 
books you are working with. The status line also allows you to change the library, book and chapter you 
are working with, go to specific pages or chapters, change the Zoom level for the current book and 
change your user mode.

When the mouse is over the toolbar, menu items or books, the status line shows the title or the function 
of the item currently pointed at. This help facility is called Flyby Help and can be disabled by changing 
the Biblos preferences.

To turn the status line on and off
choose Status line from the View menu; or
press the Status Line button on theToolbar.

Status Line options

With one or more books open, status line options from left to right are:

User mode Controls whether the user can create public accessories (sticky notes or bookmarks) 
that can be seen and used by other Biblos users on the same network. By default, the 
area shows Personal - this means that any accessories created will be private to the 
current user. Clicking on this item pops up the option of either Personal or Public. 
Selecting Public means that any accessories created will be public to all Biblos users 
on the network. Note that a password is required to enable Public mode. Public mode 
is only available in the network version of Biblos.

Library Shows the name of the current library. Clicking on this area pops up a list of all libraries 
available. Click on a library to make it current. The current library affects the books 
shown on the shelf and the scope of searches.

Book Shows the name of the currently selected book. Clicking on this area pops up a list of 
currently open books. Click on a book to make it the currently selected one. The active 
book affects the Contents Window, the Magnifying Window and searching.

Chapter Show the current chapter of the currently selected book. Clicking on this area pops up 
a list of all chapters in the currently selected book. Click on a chapter to go to that point 
in the book.

Page Shows the current page and the total number of pages in the currently selected book. 
Clicking on this area bring up the Goto tool.

If no books are open the status line will show only the current library and the user status.

See also:
Contents
Searching
Goto
Zoom



Accessories
Public Accessories
Preferences
Libraries
Zoom
Command Line Options



Public Accessories

Public accessories, unlike normal personal accessories, are visible to anyone using Biblos over a 
network. They appear green in the Accessories Toolbar and on the pages of your books to emphasize 
the fact that they are public. Public accessories are only available in the network version of Biblos.

Unless you have the Public mode password, you will not be able to create public sticky notes or 
bookmarks. You will also not be able to delete or edit them.

Whether you have the right to create, modify and delete public accessories depends on the user mode 
you are in. There are two modes, Personal and Public. Personal means that you can see public 
accessories but cannot create delete or modify them. Public mode means that you have full access to 
manage public notes for others on your network. The right hand side of the status bar at the bottom of 
your screen will tell you the mode you are currently in. Clicking on this area of the status bar will give 
you the option to change to Public mode if your Biblos administrator has given you the power to do this.

To create edit or modify public accessories, simply change to Public mode before creating or modifying 
accessories.

See also:
Status Line
Command Line Options



Adding Bookmarks

To add a bookmark to the currently active book:
1. Ensure you can see the part of the page that you want to apply the bookmark to.
2. Select Add Bookmark... from the Tools menu or click the bookmark button on the toolbar. The mouse

pointer will change to look like a bookmark.
3. Click the point on the page where you want the bookmark to be placed.
4. A dialog appears asking you to give a title to the bookmark and allocate it to a topic. Each bookmark 

must have a title. You can either select an existing topic by clicking on the list button at the right hand
side of the topic or you can type in the name of a new topic.

5. If you typed in the name of a new topic, a dialog appears asking you to confirm whether you want to 
create a new one.

6. If you are in Public mode you can choose whether the new bookmark should be public or personal 
by selecting the appropriate radio button.

7. By pressing the More>> button, you can open an area that allows you to type in a description of the 
bookmark`s purpose. This summary will appear in the Accessories Window and is useful for keeping 
track of why you placed your bookmarks without having to open books to find out.

8. When you have entered all the information about the bookmark, press Set. The bookmark now 
appears at the place you pointed to in the book.

See also:
Adding Sticky Notes
Deleting Accessories
Moving Accessories



Deleting Accessories

To delete an accessory, either:
Press the wastebasket button on the toolbar of the    and then click on the accessory you want to 

remove; or
Select an accessory in the Accessories Window and press the wastebasket button in the 

window`s title bar.

In either case, a dialog appears asking you to confirm that you really want to delete the accessory. You 
will not be able to delete a public accessory unless you are in Public mode,

See also:
Adding Sticky Notes
Adding Bookmarks
Moving Accessories



Adding Sticky Notes

To add a sticky note to the currently active book:
1. Ensure you can see the part of the page that you want to stick the note to.
2. Select Add Sticky Note... from the Tools menu or click the note button on the toolbar. The mouse 

pointer will change to look like a sticky note.
3. Click the point on the page where you want the note to be placed.
4. A dialog appears asking you to give a title to the sticky note and allocate it to a topic. Each sticky 

note must have a title. You can either select an existing topic by clicking on the list button at the right 
hand side of the topic or you can type in the name of a new topic.

5. If you typed in the name of a new topic, a dialog appears asking you to confirm whether you want to 
create a new one.

6. If you are in Public mode you can choose whether the new sticky note should be public or personal 
by selecting the appropriate radio button.

7. By pressing the More>> button, you can open an area that allows you to type in a summary of the 
sticky note. This summary will appear in the Accessories Window and is useful for keeping track of 
why you made the note without having to open the book and look at it.

8. When you have entered all the information about the note, press Set. The blank note now appears at
the place you pointed to in the book.

9. Click on the note to select it
10. Type in your note text.

If you want to change the size of the note to display more text or remove wasted space, position the 
mouse on any part of the note border. When the mouse pointer changes to a double ended arrow you 
can resize the note as required.

You can collapse a note to stop it obscuring the book by clicking on the down arrow in the top right hand 
corner. You expand the collapsed note by clicking on it again.

You can move the note around on the page by dragging the (expanded) note by its title bar.

See also:
Deleting Accessories
Moving Accessories



Bookshelf

The bookshelf or shelf imitates a conventional shelf of books. The books that you can see on the shelf 
are those in the current library. If there are more books in the library than will fit on the screen, the scroll 
button at the left hand edge of the shelf become active. You can open and close books by simply clicking
on them - a click will open a closed book or close an open book. 

You can also use the shelf to browse the contents of your libraries. Change the library using the small up
and down arrows at the left-hand edge of the shelf, the status line segment or the Library | Select menu 
option.

See also:
Libraries
Opening Books
Closing Books



Copy Text

Although Biblos does not allow you to alter the text in a Biblos book, it does allow you to copy that text to
the clipboard for use in another application. To copy the text on the open pages of a one or two page 
book: select Copy from the Edit menu or Choose the copy button from the Toolbar. One or two pages of 
text will be placed on the clipboard along with the book name and the page numbers.



Accessory Window

The Accessory toolbar summarises all public and personal accessories under each topic. The window 
provides a convenient way to inspect existing accessories and use them to follow cross references 
around your books.

Click on the example below to see what each part does.

See also:
Accessories

Adding Sticky Notes
Adding Bookmarks
Moving Accessories
Deleting Accessories



Accessories

Accessories are the tools that Biblos provide to cross reference and annotate your books. Two types of 
accessory are available:

Sticky Notes Sticky Notes work like their paper equivalents. They can be stuck into any of your 
books to add your own annotations and comments. Sticky notes can be moved 
about, stretched, shrunk and collapsed so they don`t interfere with your books.

Bookmarks Bookmarks allow you to mark sections of your books so that you can quickly refer to
them later.

Every Bookmark and Sticky Note is associated with a Topic. Topics are used to group Sticky Notes and 
Bookmarks according to their purpose.

Bookmarks and Sticky Notes are normally personal - only you can see them. However, when Biblos is 
used over a network, managers can create public accessories that are visible to everybody. Public 
accessories are only available in the network version of Biblos.

The Accessories toolbar summarises your Sticky Notes and Bookmarks by topic. By selecting the 
bookmark or sticky notes in the drop down list and pressing the accessory goto buttton you can go to the
place where you left the notes or bookmarks. Thus, it is possible to build sophisticated and powerful 
cross references using accessories. 

See also:
Adding Sticky Notes
Adding Bookmarks
Moving Accessories
Accessories Window
Adding Topics
Deleting Topics



Confirm Create Topic

You have typed the name of a topic that does not currently exist. Pressing Yes will create a new topic 
with the name you typed. Pressing No will cancel and allow you to choose an existing topic or type a 
different name.



Delete Topic

To delete a topic:
1. Choose Delete Topic... from the Tools menu.
2. Pick the topic you want to delete.
3. Press OK
4. You are asked to confirm the deletion. Press Yes to confirm or No to cancel.



Select Book Range

The book selection dialog allows you to choose one or more books from a library. The options are as 
follows:

Select a library
Choose one of the available libraries. If you aren`t sure which book you want then choose the Main 
Library as this contains all books.

Select Books
Choose one or more books by clicking to select them. You can select more than one book. Click on a 
selected book to deselect it.

Info
Provides further information about the current book. Where more than one book is selected, this button 
provides information about the first selected book only.



Adding a new topic

Type the name of a new topic and press OK. You are not allowed to use the names of topics that already
exist. 

If you are in Public mode when you create a topic then that topic will be public and visible to everyone 
using Biblos.

Note: You can also create a new topic by placing a sticky note or bookmark and typing the name of the 
new topic.



Adding a new topic

You can define new topics by choosing Add Topic... from the Tools menu.

If you are in Public mode when you create a topic then that topic will be public and visible to everyone 
using Biblos.

Type the name of a new topic and press OK. You are not allowed to use the names of topics that already
exist. 

Note: You can also create a new topic by placing a sticky note or bookmark and typing the name of the 
new topic.



Topics

Topics allow you to group accessories according to their purpose or relevance. For example, you might 
be researching the law relating to possession and sale of Cannabis. When you find sections of text that 
relate to this subject you can mark them with bookmarks or attach sticky notes to the page to explain the
relevance of the passages you have found. To manage your bookmarks and notes, you might create a 
new topic called Cannabis that groups them together for convenience. You can define as many different 
topics as you like.

If you are in public mode when you create a topic then the topic will be public and available to all Biblos 
users on your network. If you or other users create personal sticky notes or bookmarks under a public 
topic then the topic becomes mixed. A mixed topic is shown by a half green, half yellow icon.



Show Bookmarks

This button shows all the bookmarks for the current topic



Show Sticky Notes

This button show all the sticky notes for the selected topic



Delete Current Accessory

This button deletes the currently selected book mark or sticky note



Show/Hide Info

This button alternately opens and closes the information window. The information window shows details 
about the current accessory such as its location and creation date. In addition, you can press the down 
arrow button in the top right-hand corner of the window to show any text that may have been entered 
about the accessory.



Topic Selector

This selector allows you to choose a topic. for which to show all sticky notes and bookmarks. To create a
new topic, select Add Topic from the Tools menu.



Accessory List
This area lists all the sticky notes or bookmarks assigned to the currently selected topic. The list shows 
either all accessories in the current book or all accessories in all books. This is controlled by two buttons 
on the accessory toolbar.



Info 
This area shows additional information about the highlighted bookmark or sticky note. In particular, this 
area show the books the item is in, the page it is on, whether it is public or personal and the date and 
time it was applied. You can optionally type text into the area below to describe the purpose of the 
bookmark or sticky note.



Contents

The Contents Window shows the structure of the currently active book and helps you to go straight to 
the information you want.

Each chapter is shown as a symbol and a title. If the chapter has a + symbol, there is further information 
available about the structure of the chapter. If the chapter has a sheet of paper symbol then there is no 
more information about its structure.

If you single-click on any of the chapter items, the currently active book will move to the start of 
the chapter you selected.

If you double-click on any of the book symbols, the chapter will expand to show its structure. If the
chapter contains another level of structure detail, there may be further book symbols that you can double-
click on to drill down to the information you want.

To collapse parts of the contents that you have expanded, double-click on the open book 
symbols. Items that are collapsible show a - symbol.

If you make a different book active, the Contents Window will update to show the contents of the 
new book.



Removing books from a Library

To remove books from a library:
1. Choose Remove Books... from the Library menu.
2. Select the library you want to remove books from.
3. Choose the book you want to remove and press OK
4. You can press the Info button button to get more details about the book.

If you are using a network version of Biblos then you will only be able to remove books from public 
libraries if you are in public mode. Public mode libraries are shown by a green icon.

See also:
Adding books to a library
Creating libraries
Deleting libraries



Adding books to a Library

To add books to a library:
1. Choose Add Books... from the Library menu.
2. Select the library you want to add books to.
3. Choose the books you want to add to the library. The list shows all the available books in the current 

drive and directory. Books that have already been added to this library will not appear.
4. You can press the Info button button to get more details about the book.
5. Press the Dir >> buttton to choose another drive and directory if the books you want to add are not in

the current directory. As you select each directory, a list of the available titles appears above.
6. Select the book you want to add and press Add. Repeat until you have added all the books you want 

to.

See also:
Removing books from a library
Creating libraries
Deleting libraries



Deleting a Library

To delete a library:
1. Choose Delete... from the Library menu
2. Choose a library to delete
3. Press OK and Press Yes to confirm deletion of the library. Press No to cancel deletion.

If you are using a network version of Biblos then you will have the option to delete public or personal 
libraries. You will only be able to delete public libraries if you access to public mode.

See also:
Creating libraries
Adding books to a library
Removing books from a library 



Creating Libraries

To create a library:
1. Choose Create... from the Library menu.
2. If you are using a network version of Biblos and have access to public mode then you can create a 

public library. Public libraries are visible to everyone using Biblos on your network. If you have Public
access and wish to create a public library then select the appropriate radio button.

3. Type the name you want to call the new library and Press OK.
4. Choose the books you want to put in the your new library. The list shows all the available books in 

the current drive and directory. Books that have already been added to this library will not appear.
5. You can press the Info button button to get more details about the book.
6. Press the Dir >> buttton to choose another drive and directory if the books you want to add are not in

the current directory. As you select each directory, a list of the available titles appears above.
7. Select the books you want to add and press Add. Continue until you have added all the books you 

want to.

See also:
Removing books from a library
Deleting a library



Selecting Libraries

Once you have defined more than one library, you need to be aware of which is the active one. The 
active library affects what is shown on the shelf and the scope of multi-book searches.

To find out what the current library is:
Look at the status line. The name of the current library is always the second item from the left.

To change the current library:
Click on the name of the current library on the status line. A list of all available libraries will appear

from which you can choose a new one; or
If the shelf is visible, click on the up and down arrow button at the shelf`s left edge. These buttons

will cycle you through the available libraries. The shelf will change to show the books in each library and 
the name of the library will be on the status line; or

Select Select... from the Library menu and pick the library you want to change to and click OK. If 
you are using a network version of Biblos then personal libraries have a yellow icon against then in the 
list. Public libraries have a green icon.

See also:
Organising Books
Creating libraries
Adding books to a library
Removing books from a library
Deleting a library



Organising Books

Biblos helps you organise your books with Libraries. You can create as many libraries as you like and fill 
them with as many or as few books as you like. The same book can appear in any number of libraries 
(however, it is still the same book and will contain the same accessories). In Biblos, each library is 
viewed as a different shelf. By organising your books across many libraries you can make it easier to 
find the information you need.

As well as providing a convenient way to group and refer to your books, libraries can improve the way 
that searching works. For example, you might have a corporate library containing books on many 
different subjects. By creating a library of, say, tax books and another for law books, you can then opt to 
search only law books or only tax books. This can help you improve search performance and eliminate 
references to unrelated information.

If you are using the network version of Biblos then you can create public libraries that are available to all 
users on your network or personal libraries that are for you own use only. 

See also:
Creating libraries
Adding books to a library
Removing books from a library
Deleting a library
Selecting libraries



Search Options

Search options allow you finer control over your searches within Biblos. The options are:

In given order
When you search for a phrase such as bee hives. Biblos will find produce a hit for every time it finds bee
and hives within a certain distance apart (see below). Normally Biblos does not mind whether bee or 
hives comes first. However, by selecting this option you can force Biblos to generate search hits only 
when it finds the words you specified and in the order you specified them.

Allow synonyms
Biblos allows you to create synonyms that can ensure that when you search for a term such as country, 
that you get equivalent terms such as nation, territory or state. Synonyms can be created and modified 
using the Synonyms button on the search dialog.

With this option selected, Biblos will take into account any synonyms for your search word. Deselect the 
option to disable the use of synonyms. Note that synonyms will never be applied to any search terms in 
quotes such as country.

Similar sounding words
With this option selected, Biblos will find not only the word or phrase that you specify but words that 
sound similar (i.e. a phonetic search). This allows you to search for items that you don`t know how to 
spell. Note that phonetic searches never apply to search terms in quotes.

Case sensitive matches
With this option selected, Biblos will create search hits only for words that match your search word or 
phrase in capitalisation. For example, if you search for Bee, Biblos will normally find instances of bee, 
Bee, BEE and any other combination of upper and lower case letters. With this option selected, Biblos 
will only find instances of Bee. Note that searches in quotes are always case sensitive because they 
look for exact matches to the text between the quotes.

Search the following
These options control whether Biblos searches your headers and footers, sticky notes and bookmarks 
for the search word or phrase.

Headers and footers are parts of the original document that are repeated on every page Often, they 
contain one or more significant words that you might want to search for. This option allows you to 
exclude headers and footers from your searches so that you don`t generate false results.

The Sticky Note and Bookmark options, control whether these accessories get included in your 
searches. Search hits in sticky notes or bookmarks are shown in the search hit list as mini icons in the 
left-most column.

Words must be less than ... words apart
When you search for a phrase such as bee hive or bee and hive, Biblos will generate search hits for bee
and hive occurring immediately next to each other, and up to n words apart where n is the number 
entered in this box. Thus, if you enter 30, then Biblos will find all instances of bee and hive occurring 
within 30 words of each other.



See Also
Advanced Searches
Synonyms



Searching

You can use the Biblos search system to perform complex full-text searches across any or all of the 
books in Biblos. You specify the word or phrase you`re looking for and Biblos generates a list of `hits` or 
references to the places where your word or phrase appears. You can use the hit list to take you straight
to the point in each book where your word or phrase appears.

To carry out a full text search:
1. Click on the Search button on the Toolbar or select Search... from the Edit menu
2. Select the extent of your search. This can be either: the current active book, all books in the current 

library or a selection of books from the current or other libraries.
3. Choose Search the book if you want to find your phrase in the full text of a book or books. Choose 

Search Table of Contents if you want to look for your word or phrase in the titles of chapters or 
sections only. This option allows you to make out quick cross-references using the search    system. 
Choose Search Book and Contents to search both book text and Table of Contents text.

4. Type in the word or phrase you want to search for. You can use operators such as AND, OR, * and ? 
to create more advanced searches.

5. Select any special options from the Options Dialog.
6. Create any additional synonyms for parts of your search phrase from the Synonyms Dialog.
7. Press OK

A list of all the items that Biblos found will appear in a new window showing: where the hit was found,
a score out of 10 (10 is an exact match) which shows how closely the hit matched your criteria, and a
small section of text from the point where your word or phrase was found. 

In addition, all instances of the search word or phrase will be highlighted green in the books you 
included in the search.

8. Click on any one of the search items to move the book view to the place where you word or phrase 
was found. The word or phrase associated with the hit you clicked on will be highlighted red in the 
book. If you click on a hit from a book that is not currently open, that book will open in a new window 
and turn immediately to the page where your hit was found.

9. You can sort the hit list in three ways. Clicking on the leftmost segment of the description bar in the 
hit list will order your hits by the objects they were found in-book pages followed by sticky notes and 
bookmarks. Clicking on the Score title will sort the hits in to descending order of relevance. Clicking 
on the Book title will sort the hits into book and page order.

10. You can adjust the column widths in the hit list by moving the mouse over the column boundaries in 
the hit list description bar. When the mouse pointer changes to a double-headed arrow you can drag 
the columns to make them wider or narrower.

9. The Smart Tile button on the Toolbar is a quick way to organise your book and hit windows after a 
search. Pressing this button will make all the windows the same size and ensure that they don`t 
overlap.

See Also
Advanced Searches
Synonyms
Search Options



Advanced Searches

You can use the Biblos Search system to construct very specific queries using the search operators 
AND, OR, *, and ?. You can enter an operator in either lowercase or uppercase letters (for example, 
"and" is the same as "AND"). If you use multiple search operators, they are evaluated from left to right, 
by default. You can use parentheses ( ) to specify a different order-operators within parentheses are 
evaluated first.

For example:

The search: Will find:
honey AND bees Books containing both the word "honey" and the word "bees" no more 

than a certain number of words apart. This distance is defined in the 
search options dialog.

"bees love honey" Books containing the whole phrase bees love honey. The quotation marks
tell Biblos to find the text exactly as you have entered it. Any differences 
such as capital letters instead of lowercase will not yield a result.

honey bees Books containing "honey" and "bees" no more than a certain number of 
words apart (same as honey AND bees above).AND is the default 
operator.

honey OR bees Books containing "honey" or "bees" or both.
Bee* Books containing words that start with "bee" (for example, bees, beehive, 

beet). An asterisk substitution for one or more characters at the end of a 
word can be helpful if you are unsure of how to spell a word you want to 
search for.

hon?y Books containing words that start with "hon" and end with "y," with another
letter in between. This is a useful substitution when you don`t know how to
spell a word.

honey OR bees AND hives Books containing "honey" and "hives" or books containing "bees" and 
"hives."

honey OR (bees AND hives) Books containing just the word "honey" or books containing "bees" and 
"hives."

See Also
Searching
Search Options
Synonyms
Libraries



Synonyms

Synonyms allow you to create links between different words that mean broadly the same thing. Different 
books may often use different words for the same thing and synonyms allow you to ensure that your 
searches find instances for all of these. For example, different books might use the words state, country, 
nation or territory to mean the same thing. By defining the word country as having the synonyms: state, 
nation and territory, Biblos will search for all of these terms when you search for country.

Note that you can also use the synonyms feature to save searches for multiple words. For example if 
you regularly wanted to create searches that looked for the words banana, apple, orange and pear, you 
could define these words as synonyms for the word fruit. In future, you can use a search for fruit as a 
shortcut for searching for all the individual items.

If you are using the network version of Biblso then you can create personal or public synonyms. Public 
synonyms are available to everyone using Biblos on your network. Personal synonyms are private for 
your use only. You must have access to public mode to create public synonyms.

To define synonyms:
1. Select the Synonyms button from the Search Dialog or select the Synonyms... option from the Edit 

menu.
2. To define a new synonym, type a word into the main word box. Press tab or click in the Synonym box

and type the first synonym for the word. Press Add or hit the return key.
3. To add a further synonym for the word, type the next synonym in the Synonym box and press Add 

again. Repeat the process to define the full set of synonyms for your word.
4. To modify an existing set of synonyms, click on the set you require from the main word list. The right 

hand list will now show all synonyms defined for the main word. You can add additional synonyms as
in 3 above or remove existing ones by selecting them and pressing Remove.

5. The Remove All button will delete all the main word and all its synonyms.

See Also
Searching
Search Options
Advanced Searches  



Public Access

The Public Access menu option allows you to change mode from public to personal and back again. This
option is only available in the network version of Biblos.

To change mode from Personal to Public mode you will need to enter the public password. This 
password is set in the Network Control Application Bibnet.exe.

In public mode you are able to create public libraries, synonyms, topics, bookmarks and sticky notes. 
Once created, these public items are available to everyone using Biblos on your network. Even if you 
are in public mode, you can still create personal libraries, synonyms, topics and accessories that are 
private.



Directories

The Directories dialog allows you to define the location of your public and personal directories. You 
should not normally need to change these unless you are setting up a Biblos system. If you do change 
these settings, pressing the Default button will reset the Public and Personal directories to those defined
in your installations NET.INI file.



Wrong Password

You have entered the wrong password to enter public mode. Public mode allows you to create, modify or
delete libraries, synonyms, topics, sticky notes and bookmarks that are shared with everyone on your 
network. You are currently in personal mode which allows you to modify these items for your own use 
only.

The password to enter public mode is set by the Biblos administrator on your network using the Biblos 
Network Control application. Refer to the Biblos administrator for more information.



Printing Problems

You have encountered problems while trying to print from Biblos. These problems have been generated 
by Windows itself rather than Biblos. To solve the problem, try checking the following:

Do you have the printer turned on and on-line?
Is the printer cable properly connected at both ends?
Is the printer out of paper, ink or toner?
Are you using the correct driver for the current printer?
Is Windows trying to use a port other than the one that the printer is connected to?
Are you short on disk space - Windows uses your disk to hold a temporary copy of the document you 
are printing?
If printing over a network, are you correctly set up to share a remote printer?



Can't delete the last topic

There must always be at least one topic present in Biblos. You have just tried to delete the last available 
topic.



Free Reader

You are using the free version of the Biblos reader. This version is fully functional except that:

- You can only have one library
- You can have a maximum of 5 books on your shelf
- Network features such as shared libraries or sticky notes are not available

If you would like to know more about the single user or network versions of Biblos then contact:

Point of Reference Ltd
62 Killyon Road
London SW8 2XT

Telephone: +44 (0) 171 610 6501
Fax: +44 (0) 171 610 6502
Email: point@book.demon.co.uk



Personal Mode

This is a limited function version of Biblos and you are not able to change from Personal to Public Mode.

The network version of Biblos allows you to work in public mode so that you can create and modify 
libraries, topics, synonyms, sticky notes and bookmarks that are shared with everyone on your network. 
Amongst other things, this allows you to publish updates, pending changes or comments in Biblos books
on your network. 

If you would like to know more about the network version of Biblos then contact:

Point of Reference Ltd
62 Killyon Road
London SW8 2XT

Telephone: +44 (0) 171 610 6501
Fax: +44 (0) 171 610 6502
Email: point@book.demon.co.uk



Printer Setup

The printer setup dialog allows you to choose the printer that you want to use with Biblos or change a 
printer`s settings. The dialog shows a list of all the printers that are available to you. To choose a 
different printer from the one that Windows applications normally print to, select the name of the print 
and press Set as Default Printer. This printer will become the new default printer for all Windows 
applications. If the printer you want is not shown, you should check that the printer has been installed in 
the printer control panel.

To change aspects of your printer`s setup such as the paper size or print quality that it uses, select the 
printer you want to modify and press the Options button. The options shown under the setup button 
depend on the printer you select. You should refer to the printer manual for further details.



KCredits

Talented bunch eh?!



About Biblos

The About Biblos shows information about the version of Biblos that you are using such as copyright and
licensing details, the software version and the names of those involved in producing Biblos.

For more information, contact:

Point of Reference Ltd
62 Killyon Road
London SW8 2XT

Telephone: +44 (0)171 610 6501
Fax: +44 (0)171 610 6502
Email: point@book.demon.co.uk



Command Line Options

When you start Biblos, you can optionally pass it the following parameters:

\SUPER Allows the user to select Public mode for creating and modifying public 
accessories. Biblos starts in Personal mode-users click the leftmost segment 
of the Status Line to select Public mode.

bookname.bbk Starts Biblos and opens the specified book. Bookname must be the fully 
qualified file name of the book including the drive and full path. 



Next Hit Button
The next hit button is equivalent to clicking on the next item in the search hit list. The active window 
shows the position of the next hit in the order shown in the search hit list. The hit is highlighted red. 



Panning

The panning tool gives you an alternative to the scroll bars for moving a book view in a window that isn`t 
big enough to display the whole page. The panning tool is hand that allows you to grab the page and drag
it to a new position.

To pan your page:
Click on the panning button or choose Pan from the View menu. Move the cursor over a book page and 
the cursor will change to a hand. Now, if you hold down the left mouse button, you can drag the page 
around within the window. Once you let go, the cursor reverts to normal. You must select the panning tool 
again to do further pans.



Moving Accessories

There are times when you will want to move sticky notes and bookmarks from one page to another or 
even to different books. Biblos provides a facility called the Pasteboard to hold accessories while you 
move them.

How to move accessories

1. Open the pasteboard by selecting Pasteboard from the View menu or dragging the edge of the 
pasteboard from the extreme right-hand edge of the application window.

2. Drag one or more accessories onto the pasteboard. You must drag sticky notes by their title bar. You 
can also select the scissors button on the accessories dialog to cut the currently selected accessory 
onto the pasteboard.

3. Choose where you want to move the accessories to. Either turn to the new page in the same book or
open a new book at the right page.

4. Drag the accessories off the Pasteboard to the page you want them to appear on.

Note that you can replace accessories on the Pasteboard in their original locations by double-clicking on 
them.

See also:
Accessories
Adding Sticky Notes
Adding Bookmarks
Accessories Window
Adding Topics
Deleting Topics



Toolbar Scroll Buttons

These button scroll the toolbar left or right to move buttons into view on small screens or at small 
window sizes.



Printing

Biblos allows you to print out all or part of any book available to you (some books may have pre-
imposed restrictions on the maximum number of pages you can print at one time).

To print an excerpt from the currently active book, select Print... from the File menu or choose the printer
button on the toolbar.

Print dialog options:

Printer
The currently selected printer. Choose the Printer... option to change this if necessary.

Print What
Controls what you want to print. The options are the book itself (default), the current Hit List (if any), the 
Table of Contents or the Accessories.

Copies
Enter the number of copies you would like printed. Note that Biblos will collate multiple copies for you if 
you check the Collate Copies box (see below).

Page Range
Allows you to select what part of what books you want to print. Selecting Current page will print the one 
or two page spread that is currently open. Selecting pages allows you to input start and ending page 
numbers to print from the current active book. Selecting Books makes the Select... button active. This 
produces a dialog which allows you to choose one or more books to print.

Print
Controls odd or even page printing. You can select from All page in range (default), Odd pages or Even 
pages.

Print to File
If this option is checked, your selection will be printed to an ASCII text file rather than to the printer. You 
will be prompted to provide a file name and a destination drive and directory for the file.

Collate Copies
If this option is checked, Biblos will print multiple copies of a page range as separate sets. If the option is
not checked, Biblos will print as many copies as requested of each page immediately after one another 
before moving on to the next page.

Options

Produces the Print Options dialog that allows you to control the content and appearance of your prints.

Printer
Produces the Printer Setup dialog that allows you to change printers and adjust printer settings.





Print Font

This dialog controls the font for prints of accessories, the hit list and Table of Contents. Select a font from
the list on the left-hand side and a font size from the list of the right. Take care not to choose a font size 
that will flow your print off the edge of the page.



Print Options

Print options control the appearance of documents when you print them from Biblos.

Print Options:

Headings
These options, Information and Courtesy,    allow you to control whether the Biblos information and 
courtesy lines are printed at the top of each page, at the bottom of each page or not at all. The 
information line shows the names of the book, the page numbers and the date and time of printing. The 
courtesy line contains a message that you can enter in the courtesy area at the bottom of the dialog.

Others
Allow Page Orientation
Print graphics When this option is selected, grpahics in documents will be printed along 

with the text. When this option is deselected, the document layout will 
remain the same but the spaces previously occupied by graphics will be 
empty.

Print accessories When selected this option forces Biblos to print accessories markers for 
each accessory contained in the printed range of pages. The markers 
appear on the printed page as they do on screen.

List accessories When selected, this option forces Biblos to list the details of each accessory
contained in the printed range of pages. All accessories in the printed range 
will be listed, starting on the page after the last document page.

Force monochrome When selected, this option forces monochrome printing of colour graphics. 
This may improve speed and appearance of colour graphic printing on 
monochrome printers.

Show Search Hits When selected, highlighted words resulting from the last search are printed 
shaded grey. When deselected, the shading is not shown.

Font
Allows you to select a font and font size for all Biblos list prints. Biblos documents will print out as they 
originally looked.

Courtesy line
Allows you to enter an optional message to be printed as specified by the Courtesy selector above.

See Also:
Print Font
Printing



Book Information

Displays details of the currently selected book`s Title, Publisher, Author and Copyright message. The 
dialog also shows the filename and path of the book.



Run Windows Utilities

The Run... option from the Control Box in the top right hand corner of the Biblos main window provides a
convenient shortcut for running the following Windows utilities:

Control Panel
Clipboard Viewer
Print Manager
File Manager

Simply select the utility you want to run and press OK.



Confirm Delete

Press Yes to confirm deletion of this topic. Press No to cancel



Confirm Delete

Press Yes to confirm deletion of this accessory. Press No to cancel.



Cut Accessory

This button cuts the currently selected accessory onto the pasteboard. The pasteboard is a holding area 
for accessories that can be used to move them between pages or books.



Biblos Versions

This version of Biblos has some features disabled. 

The network version of Biblos allows full multiuser access including public and private libraries, topics, 
synonyms and accessories. The single user and free versions of Biblos do not have these features.

In addition, the free version of Biblos allows only a single library and up to 5 books.



Confirm Delete

Press Yes to confirm deletion of this library. Press No to cancel. 

Note that if you to choose to delete this library, you are not removing any books from your system - you 
are merely removing a reference to them.



Goto start of book

More help



Go back one page

More help



Goto end of book

More help



Go forward one page

More help



Smart Tile

More help



Panning Tool

More help



View book at zoom setting

More help



View whole book page(s)

More help



View full width of book

More help



View single page

More help



View two pages

More help



Start Search

More help



None



Printing Status



Search Status



Accessory Window



Information Window

No help is available on this topic



Maximum Number of Users Reached

This is a network version of Biblos. Biblos licenses are sold on concurrent usage. This means that if your
organisation has bought, say, a 50-user licence for Biblos then a maximum of 50 people can use Biblos 
at any one time irrespective of the number of people with Biblos installed on their PCs. 

The message that you have just had means that the maximum number of concurrent users are already 
using Biblos. For now, you will have to wait until someone else stops using Biblos - perhaps wait for 5 
minutes and try again. Or, persuade someone who has Biblos running but isnt using it to log off.

In the longer term you may want to consider increasing the number of licenses you own. For more 
information contact:

Point of Reference Ltd
62 Killyon Road
London SW8 2XT

Telephone: +44 (0) 171 610 6501
Fax: +44 (0) 171 610 6502
Email: point@book.demon.co.uk






